This version of the software has been retired.
Table of Contents

Conventions Used in this Document ......................................................................................... 3
Before You Install ..................................................................................................................... 5
  Hardware and Software Compatibility .................................................................................. 7
  Minimum Hardware Requirements ....................................................................................... 7
  Supported Software ............................................................................................................... 8
  Email Server Compatibility ................................................................................................. 8
Support and Training ................................................................................................................ 8
  Telephone Support ............................................................................................................... 8
  Sage Customer Portal ......................................................................................................... 8
Training .................................................................................................................................. 8
  Sage University .................................................................................................................. 8
  MyAssistant YouTube Channel .......................................................................................... 8
  Local Business Partner ...................................................................................................... 8
Chapter 1 – Installing MyAssistant Server ............................................................................. 9
  Step 1 – MyAssistant Server Installation .......................................................................... 10
  Step 2 – MyAssistant License Agreement ........................................................................ 11
  Step 3 – Prerequisites for MyAssistant Server ................................................................. 12
  Step 4 – MyAssistant Software ......................................................................................... 13
  Step 5 – You Have Completed Installing the MyAssistant Server .................................... 14
  Start the MyAssistant Configuration Manager .................................................................... 15
Chapter 2 – MyAssistant Server Configuration ................................................................. 16
  Read this section carefully ................................................................................................. 16
  MyAssistant Server Configuration steps: ......................................................................... 16
  Considerations before you begin: ..................................................................................... 16
  Step 1 – Welcome ............................................................................................................... 17
  Step 2 – Product Activation ............................................................................................... 18
  Step 3 – Database Connection .......................................................................................... 19
  Step 4 – Create the MyAssistant Database ...................................................................... 20
  Step 5 – Sage 300 CRE Data Folders ............................................................................... 21
  Import Sage Database Customizations ........................................................................... 22
  Step 6 – Notification E-Mail Account .............................................................................. 23
  Determining Mail Settings in Outlook for Microsoft Office 365 .................................... 24
  Determining Mail Settings in Outlook 2013 ...................................................................... 25
  Determining Mail Settings in Outlook 2010 ..................................................................... 26
  Step 7 – Server Options .................................................................................................... 27
Chapter 3 – Installing MyAssistant Workstation

Step 1 – Welcome ................................................................. 30
Step 2 – MyAssistant License Agreement .................................. 31
Step 3 – Prerequisites for MyAssistant Workstation .................... 32
Step 4 – Install the Software ................................................... 33
Step 5 – You Have Completed Installing MyAssistant .................... 34

Chapter 4 – MyAssistant Workstation Configuration .................. 35

Step 1 – Welcome Screen ....................................................... 35
Step 2 – Product Activation ................................................... 36
Step 3 – Entering Sage 300 CRE Data Folder Information .......... 37
Step 4 – User Profile ............................................................ 38

Chapter 5 – Additional Settings ............................................... 39

Antivirus Exceptions ............................................................ 39
MyAssistant Drive Mapper Tool ............................................. 39

Chapter 6 – Installing on a Terminal Server .............................. 43

What is Involved .................................................................... 43
Before Installing .................................................................. 43
   If on Windows 2008: ......................................................... 43
   If on Windows 2012: ......................................................... 43
Installing the MyAssistant Server .......................................... 43
Activating the MyAssistant Workstation ................................. 43

Conclusion ........................................................................... 44
Conventions Used in this Document

This document uses the following conventions:

- The names of screens, windows, fields, and other features displayed by the software are shown in **bold type**.
- Information you enter into the software is in bold type, as in the following example: Enter *Miscellaneous* in the *Amount Type* box.
- Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key names indicates that you should press both keys at the same time; for example, SHIFT + TAB.
- The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK] and [Post].

**TIP:** Helpful information to make your experience better.

**NOTE:** This symbol draws your attention to information of particular interest such as information not included in steps.

**CAUTION:** This symbol draws your attention to information that is important because it can help you avoid a costly or time-consuming error.

**IMPORTANT:** This symbol draws your attention to information that is of critical importance.
MyAssistant Installation Guide

This document steps you through the installation and configuration of the Sage 300 CRE MyAssistant software. This process consists of the following steps:

1. Installing the MyAssistant Server software on your Sage 300 CRE Server.
2. Configuring the MyAssistant Server software by stepping through the MyAssistant Configuration Wizard.
3. (Optional): Installing the MyAssistant Drive Mapper tool. Refer to Chapter 5 to determine if you need to install this tool.
4. Installing MyAssistant on the desktop computers or Terminal/Citrix Servers where MyAssistant will be used.
5. Activating and configuring the MyAssistant software for each Windows user that will use MyAssistant.

Installing and configuring the MyAssistant server should take approximately 40 minutes. Installing each MyAssistant workstation should take approximately 10 minutes.

⚠️ CAUTION: If you are upgrading from a previous version of MyAssistant, please refer to the MyAssistant Upgrade Guide for upgrade instructions. Please contact Sage Support if you need a copy of the Sage 300 MyAssistant Upgrade Guide.
Before You Install

1. Identify the computer where the MyAssistant server will be installed. Installing the MyAssistant server software on your Sage 300 CRE server is recommended. If this is not an option, the MyAssistant server software can be installed on another machine, but it must be installed on a server operating system with a compatible version of the Sage 300 CRE software installed.

2. The computer where the MyAssistant server software is installed must meet the minimum Sage 300 CRE MyAssistant Hardware & Software requirements and must be left on 24/7.

3. Identify a Sage 300 CRE User and password that will be used to access Sage 300 CRE data from MyAssistant. This Operator should have sufficient security privileges to access the Sage 300 CRE data that you would like MyAssistant to monitor.

**IMPORTANT:** Confirm that the password for this Sage 300 CRE User is set to never expire.

4. Select the Email account / address that MyAssistant will use to send Notification email messages. You will need the name or IP address for the outgoing mail server, as well as the user name and password used to log into the email account. See the Notification Email Account topic in Chapter 2, Step 6 for instructions.

5. Identify the computers (desktops or Citrix/Terminal servers) where the MyAssistant workstation software will be installed. The MyAssistant workstation software needs to be installed for the users who will set up MyAssistant Tasks, view Notifications from the MyAssistant Live Tile, and run MyAssistant Tasks or work with their Notifications in the Sage Desktop.

6. If your network is monitored by a proxy server, you will need to provide a proxy server user and password to activate the MyAssistant software.

**NOTE:** MyAssistant will need to be activated for each Windows user that will use the software. This applies to the use of MyAssistant on standalone workstations and Citrix or Terminal servers. The MyAssistant Product Key determines the features available to each user.

- The **MyAssistant Server** product key is used on the MyAssistant server. This key provides access to the MyAssistant Server software.

- The **MyAssistant Designer** product key provides access to setup features such as creating and scheduling MyAssistant Tasks and defining security. This key provides all of the functionality of the MyAssistant application.

- The **MyAssistant** product key allows users to view and work with Notifications in the Sage Desktop and MyAssistant Live Tile.

7. Verify you can start the Sage 300 CRE software on each computer, including the server where MyAssistant Server Software will be installed.

8. If you are using the Sage 300 CRE Service Management application, you must open Service Management and run a report to ensure that an ODBC connection to the SM database has been established.

9. Ensure the latest Microsoft updates have been installed. We recommend installing all High Priority updates.
TIP: Restart the server where MyAssistant Server will be installed prior to your installation. This will complete any Windows or other software updates where a restart is required to complete.

10. Confirm that Windows User Access Control (UAC) is turned off on ALL machines where MyAssistant will be installed. User Account Control settings can be found by going to Control Panel > User Accounts > Change User Account Control settings.

   - If the MyAssistant Server is going to be installed on a Windows 2008 R2 Server or later, UAC will need to be deactivated in the registry. Turn at the following path:
     - HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System
     - Double click on “EnableLUA” and change the value to “0”, then click “OK”

   - UAC needs to remain off on the machine where the MyAssistant Server is installed. This includes Terminal/Citrix environments when the MyAssistant Server is installed on the Terminal/Citrix server.

IMPORTANT: Turn off any antivirus and firewall software on server where the MyAssistant server will be installed. That software can be turned on again after the MyAssistant Server installation and activation have both completed, but exceptions will need to be added (see Chapter 5 for more details).

11. Sage 300 CRE MyAssistant installs the following software:

   - Microsoft SQL Server 2008 Express R2 with SP1 (On the Server Only)
   - Sage 300 CRE MyAssistant software

Removing any of the above will disable the Sage 300 CRE MyAssistant software.

IMPORTANT: Confirm that the Windows users installing and configuring have access to the following locations:

   - On the MyAssistant Server: Access to Program Files, Program Data, and can write to the Local Machine hive of the Windows Registry.
   - On a MyAssistant Workstation: Access to Program Files, Program Data, and can write to the Current User hive of the Windows Registry.
Hardware and Software Compatibility

Minimum Hardware Requirements
The following are the minimum hardware requirements for the Sage 300 CRE MyAssistant software.

- 2 GB of RAM when using Windows VISTA or later
- 2 GB of RAM when using Windows Server 2008 R2 or later
- 1 GB of available disk space on workstations and 5 GB on the server
- Video card capable of 1024 x 768 resolution

Supported Software
The Sage 300 CRE MyAssistant software version 15.1 must be installed on a computer running one of the following operating systems:

- Windows Vista Business or Ultimate with SP1 (32 or 64 bit)
- Windows 7 (32 or 64 bit)
- Windows Server 2008 R2 (32 or 64 bit)
- Windows Server 2012
- Windows 8.1 (32 or 64 bit)
- Windows 10 (32 or 64 bit)

The MyAssistant Server software should be installed on your Sage 300 CRE 15.1 server. If this is not possible, the MyAssistant server software can be installed on another machine running one of the Windows Server operating systems listed above.

MyAssistant version 15.1 is compatible with Sage 300 Construction and Real Estate v15.1.

MyAssistant must be installed on a computer with a constant connection to the Internet and with access to the MyAssistant Activation server.

A time synchronization service such as Windows Time Service must be activated on all machines where MyAssistant is installed.

Sage 300 CRE Security must be enabled to send Report Designer or Crystal reports that are listed on a Sage 300 CRE Reports menu.

Email Server Compatibility
MyAssistant is compatible with most SMTP compatible email servers. MyAssistant has been tested with Microsoft Exchange and Gmail.
Support and Training

Telephone Support
When you would like to speak to a customer support analyst directly, call us at 800-551-8307. Telephone support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the following exceptions:

- Every Thursday from 2 p.m. to 3 p.m. Pacific time (closed for customer support staff meetings)
- Standard United States holidays
- Quarterly company meetings

Sage Customer Portal
You may log on to the Sage Customer Portal at: https://customers.sagenorthamerica.com/irj/portal/anonymous/login.

The portal provides access to the following services:

- Knowledgebase: Find answers to your questions, access downloads, and subscribe to your favorite articles. This service is available online 24/7.
- Live Chat: Chat online with a customer support analyst, a great option for quick questions. Chat hours are Monday through Friday from 6 a.m. to 3 p.m. Pacific Time, with the same exceptions as telephone support.
- Online Support Request: If you have a question or an issue that is not urgent, you can submit an online support ticket. A customer support analyst will contact you during regular telephone support hours.

Training
Sage University
Sage University offers both recorded and live training sessions. Visit SageU.com for currently available and upcoming classes.

How to access MyAssistant training options in Sage University:
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. In the page that opens, click [Product Training] on the left side of the screen.
4. Click [MyAssistant] in the list that opened.
5. Select either [Real-time Learning] or [Replay Learning] and review the available options in each.

How to access Complimentary MyAssistant Training in Sage University:
2. Click [Customer Training] and select your Sage 300 Product from the list.
3. Click [Complimentary Training] on the left side of the screen.
4. Review the list of complimentary classes for a MyAssistant option.

MyAssistant YouTube Channel
The MyAssistant YouTube channel offers a variety of MyAssistant training videos. Subscribe to the MyAssistant YouTube channel to be notified when new videos are added.

How to access the MyAssistant YouTube channel:
1. Enter www.YouTube.com/MyAssistantTraining into a web browser.
2. The channel will open with all available videos listed.
3. Click on a video to watch.

Local Business Partner
Contact your local Business Partner to learn what types of MyAssistant training they can provide.
Chapter 1 – Installing MyAssistant Server

Perform the following to initiate the MyAssistant Server installation:

1. Confirm that the operating environment (hardware and software) meets the Sage 300 CRE MyAssistant Hardware and Software requirements. These requirements are outlined in the Before You Install section of this document.

2. Log on to your future MyAssistant server with a Windows user that has Administrator permissions.

3. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that may be running.

4. Confirm that all software updates / installations have been completed by restarting the server prior to installing MyAssistant.

5. Using the link provided by Sage Software, download the MyAssistant installation files and save the .ZIP file to a folder on your machine. Consider saving the .ZIP file to a shared folder so it is accessible from any workstations where MyAssistant will be installed.

6. Perform the following to initiate the MyAssistant Server Installation:
   a) Open the location of the downloaded MyAssistant Installation files.
   b) Unzip the files to a folder on the local drive on the server.
   c) Open the folder of unzipped MyAssistant installation files and double click autorun.hta

7. The Sage 300 CRE MyAssistant Installation hub will open.

Click [Install Server] to initiate the MyAssistant Server installation.
Step 1 – MyAssistant Server Installation

The MyAssistant Installation wizard displays once you have selected the type of install.

Click [Next] to continue.
Step 2 – MyAssistant License Agreement

You must accept the License Agreement below to use the Sage 300 CRE MyAssistant software. A complete copy of the Innovative Software Design License Agreement is provided with the MyAssistant installation files.

If you agree to the terms of the License Agreement, check the I accept the terms in the license agreement checkbox and click [Next] to continue.
Step 3 – Prerequisites for MyAssistant Server

This window is only displayed if any of the MyAssistant prerequisites are missing. The green check marks indicate which prerequisites are already installed, while the blue circle indicates those that are missing.

NOTE: Only check the “Do not install SQL Server Express” box if you have separately purchased, installed and will be using a full version of the Microsoft SQL Server database. Do not check this box if you are unsure if you have a full version of Microsoft SQL Server installed. By checking this box you are taking full responsibility for the installation, setup, and maintenance of the SQL Server instance used with MyAssistant.

Given the system resource requirements of Microsoft SQL Server Express, installing more than two SQL Server Express Instances on the same machine will most likely result in performance issues. To prevent this, you can install the MyAssistant Server software on another server as long as it meets the Hardware Software requirements specified in the introduction of this document.

Click [Next] to begin the install of the necessary prerequisite software.

IMPORTANT: The SQL Server install can take up to 20 minutes. Please be patient. Do not cancel the SQL install.
Step 4 – MyAssistant Software

In this step you will determine where the MyAssistant program files will be installed on your server.

Accept the default location or use the **Browse** button to specify a different location.

Click **Next** to install the MyAssistant software.
Step 5 – You Have Completed Installing the MyAssistant Server

Congratulations, you have completed installing MyAssistant Server software.

Click [Finish] to close the wizard.

NOTE: You must complete the Configuration Manager on the server before installing MyAssistant on any Workstations.
Start the MyAssistant Configuration Manager

After clicking Finish, you will be prompted to start the MyAssistant Configuration Manager.

Click [Yes]. Continue to Chapter 2 to walk through configuring the MyAssistant Server.

If you elect to not run the MyAssistant Server configuration at this time, you can configure the MyAssistant server later using the MyAssistant Configuration Manager application.
Chapter 2 – MyAssistant Server Configuration

This chapter walks through configuring the MyAssistant Server software. This process must be done before installing MyAssistant on any workstations.

Read this section carefully

MyAssistant Server Configuration steps:

1. Activate the software.

2. Select a list of prebuilt Tasks (Construction or Real Estate) to create with your MyAssistant database.

3. Enter the Sage 300 CRE operator ID and password that MyAssistant will use to access Sage 300 CRE data, and specify one or more Sage 300 CRE data folders MyAssistant will monitor.

4. Configure server options, including preferences on daily email summaries, error notifications and service settings for running Tasks and sending emails with Notifications.

   **NOTE:** Configuring the MyAssistant Server will take approximately 10 minutes.

Considerations before you begin:

1. If you use Service Management in the Sage 300 Construction and Real Estate software, open the module and run a report. This will verify your connection to the ODBC driver.

2. Confirm that the password associated with the Sage 300 CRE user that MyAssistant will use to access the Sage 300 CRE database does not expire.

3. Any of the configuration settings except the prebuilt Tasks can be changed at a later date.
Step 1 – Welcome

If the MyAssistant Configuration wizard isn’t started, it can be started using the desktop icon or from following this path: Windows Start > All Programs > MyAssistant > MyAssistant Configuration Manager.

Check the box next to Show Advanced Options if:
- You are using a Web Proxy Server.
- Are using a full version of the Microsoft SQL Server database.
- Would like to define the Microsoft SQL Server credentials that will be used access MyAssistant data.
Step 2 – Product Activation

MyAssistant must be activated for each Windows user on each computer that will be used. One MyAssistant license is required for each user on each computer.

To activate the software, enter a valid customer number and server product key, both of which were provided with the MyAssistant software. If you do not have this information, please contact Sage Support.

- **Customer number** – Enter your Sage customer number.
- **Product Key** – Enter your Server product key.

**NOTE**: The Web Proxy Server checkbox will only appear if you selected Show Advanced Options in the Welcome step (Step 1).

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and provide the requested information.
Step 3 – Database Connection

**NOTE:** This step will only be available if you click [Show Advanced Options] in the Welcome step.

This step gives you access to the server name, SQL Server credentials, and SQL Instance and Port Number MyAssistant is using to connect to the Database.

**CAUTION:** Making changes to this step can break the connection to the MyAssistant database. These fields should only be changed by someone with in-depth knowledge of SQL Server.
Step 4 – Create the MyAssistant Database

Select the type of prebuilt Tasks you would like MyAssistant to install. This selection is permanent and cannot be changed for the database being created.

Once a set of prebuilt Tasks is selected, click [Next] to start the database creation.

**NOTE:** See the “Prebuilt Task List” documents in the MyAssistant install files for a list of the Construction and Real Estate prebuilt Tasks.
Step 5 – Sage 300 CRE Data Folders

This step is used to specify the Sage 300 CRE data folder(s) that MyAssistant will monitor. Multiple Sage 300 CRE data folders can be entered.

Sage 300 CRE operator ID – Enter the Sage 300 CRE ID MyAssistant will use to access the Sage 300 CRE database when Tasks are run. Leave this blank if Sage 300 CRE security is not activated.

**IMPORTANT:** Using a Sage 300 CRE operator ID where the password does not expire is highly recommended.

Sage 300 CRE password – Enter the password associated with the entered operator ID.

Specify the Sage 300 CRE Data Folder(s) – MyAssistant will automatically create an ODBC data connection (Window DSN) for the specified Sage 300 CRE data folder(s). Click [Add Data Folder] to specify one or more data folders.

**IMPORTANT:** If the MyAssistant Server is not on the same computer as the Sage 300 CRE Server,
use a local drive or UNC path. If using a mapped drive, the MyAssistant Drive Mapper will need to be set up. Please see Chapter 5 for more information on the MyAssistant Drive Mapper.

Click [Next] to continue.

**Import Sage Database Customizations**

If only one data folder is selected, MyAssistant will automatically import the Sage Database Customizations for that folder when you click [Next]. If there is more than one folder available, clicking [Next] will cause a window to appear asking to specify which data folder’s Sage Database Customizations you wish to import. Importing Sage Database Customizations can be run as often as necessary, and accessed at any time after the initial installation via the MyAssistant Configuration Manager. Please note you can only import Sage database customizations for one data folder.

The connections to the Sage 300 CRE data folders will be tested when you click [Next].

**NOTE:** When you create a custom field in Sage 300 CRE you must import Sage database customizations for MyAssistant to recognize the change. Again, you can only import Sage database customizations for one data folder.
Step 6 – Notification E-Mail Account

MyAssistant provides the ability to send emails with Notifications to specified people when a condition is met. These emails will originate from the name and email address specified in this step.

**From Name** – Enter the name that email messages containing MyAssistant notifications will come from. This name is displayed in the recipient’s Inbox.

**From E-mail Address** – Enter the email address from which Notification email messages will be sent.

**Outgoing Mail Server** – Sent email messages are routed through an email server. If using Microsoft Exchange, the Exchange server should be used. If Microsoft Exchange is not being used, the email server is determined by your Internet Service Provider (ISP). Enter the name of the outgoing email server associated with the **From E-mail Address** entered. Refer to the instructions on the following pages to determine the name of your outgoing email server.

**Username** – Enter the user name to log on to the specified email account. Refer to the instructions on the following pages to determine the username for the email address entered in the **From E-mail address** field.

**Password** – Enter the password for the specified email account.
Check the box for **This server requires an encrypted SSL connection** if your email server requires a secure connection.

**Determining Mail Settings in Outlook for Microsoft Office 365**

Perform the following to determine the outgoing mail server and user name for a specified email address when using Outlook for Microsoft Office 365.

1. Log onto the machine as the Windows user that can send an email from the account/address MyAssistant will use to send Notification Emails.
2. Start Microsoft Outlook.
3. Click on the **File** tab and select the **Account Settings** option.
4. In the drop down menu that appears, click **[Account Settings]**.
5. Select the email accounting that will be used in the Account List, then click **[Change]**.
6. Enter the name displayed in the **Mail Server** field as your outgoing mail server.
7. Enter the user name displayed in the **User Name** field as your email username.

![Change Account](image)
Determining Mail Settings in Outlook 2013

Perform the following to determine the outgoing mail server and user name for a specified email address when using Outlook 2013.

1. Log onto the machine as the Windows user that can send an email from the account/address MyAssistant will use to send Notification Emails.
2. Start Microsoft Outlook.
3. Click on the **File** tab and select the **Account Settings** option.
4. In the drop down menu that appears, click [**Account Settings**].
5. Select the email accounting that will be used in the Account List and, click [**Change**].
6. Enter the name displayed in the Microsoft Exchange Server or Outgoing Mail Server field as your outgoing mail server.
7. Enter the user name displayed in the User Name field as your email username.

![Change Account Window](image.png)
Determining Mail Settings in Outlook 2010

Perform the following to determine the outgoing mail server and user name for a specified email address when using Outlook 2010.

1. Log onto the machine as the Windows user that can send an email from the account/address MyAssistant will use to send Notification Emails.
2. Start Microsoft Outlook.
3. Click on the File tab and select the Account Settings option.
4. In the drop down menu that appears, click [Account Settings].
5. Select the email accounting that will be used in the Account List and, click [Change].
6. Enter the name displayed in the Microsoft Exchange Server or Outgoing Mail Server field as your outgoing mail server.
7. Enter the user name displayed in the User Name field as your email username.
Step 7 – Server Options

This final step is used to determine a variety of settings around the MyAssistant Server.

**Daily Summaries:** MyAssistant Daily Summary email messages are used to send each recipient their Notifications across several Tasks in one email message. See the MyAssistant User Guide for more information. This time entered should be after all of your Tasks have ran.

**Send Errors To:** Someone to be notified when MyAssistant encounters an error. It is recommended to send error messages to the primary MyAssistant user.

**Save MyCommunicator Email Messages:**
Sage MyCommunicator for Outlook allows you to centrally track users’ email correspondence related to your business. In addition to creating a record of business related emails, a copy of the mail messages can be save and linked to your Sage data (e.g. Jobs, vendors, customers, etc). To enable this function, check the box in this section and click [Browse...] to select a folder location.

**Running Tasks and Sending Service Settings:**
MyAssistant runs Tasks, sends emails and updates Sage data with MyCommunicator via background processes (i.e. Windows Services) on the server. These processes are now scalable to increase performance, and can auto-correct in the event of a hang.
These MyAssistant Services (named ISDAdminTaskService and ISDAdminSenderService) start other processes named “TaskRunner*32,” which each take 30-50Mb of memory when idle. Many variables affect the system resources used when Tasks run and emails are sent, including:

- The available server memory
- Disk drive performance
- Other server demands at the time the MyAssistant Tasks are run. For example, running Tasks at night may allow additional server resources to be dedicated to MyAssistant.

Perform the following to determine the optimal number of processes:

- Complete the MyAssistant server configuration with the default settings and the MyAssistant workstation installation.
- Activate two MyAssistant Tasks you will regularly use.
- Monitor the server memory usage and disk queue lengths when both Tasks are run concurrently.
- Open the MyAssistant Configuration Manager and increase or decrease the number or processes based on available server resources.

Click [Finish] to close the MyAssistant Server Configuration Wizard.

Once the Configuration Wizard is closed, the Server portion of the MyAssistant installation is complete. Continue to Chapter 3 to install the MyAssistant Workstation.
Chapter 3 – Installing MyAssistant Workstation

**IMPORTANT:** If you are installing on a Terminal or Citrix Server, please move to Chapter 6.

Before beginning the MyAssistant installation on your workstation, make sure you can open Sage 300 CRE on the machine. If you use Service Management, also open Service Management and run a report to ensure the ODBC connection to the SM database has been established.

Perform the following to install MyAssistant:

1. Log on to the machine that will be the Sage 300 MyAssistant workstation with a Windows user that has Administrator or Unlimited permissions.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that may be running.

3. Confirm that all system software updates/installations have been completed by restarting the machine prior to installing MyAssistant.

4. Using the link provided by Sage Software, download the MyAssistant installation files and save the .ZIP file to a folder on your machine. If accessible from the workstation, you can use the same files that were used to install on the MyAssistant Server. Perform the following to initiate the MyAssistant Workstation Installation.
   a) Open the location of the downloaded MyAssistant Installation files.
   b) Unzip the files to a folder on the local drive on the machine.
   c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

5. The Sage 300 CRE MyAssistant Installation hub will open.

**Install Workstation** – Select Install Workstation to begin the MyAssistant Workstation install process.
Step 1 – Welcome

When you select **Workstation Install** in the MyAssistant splash screen, the Setup Workstation wizard will appear.

Click **Next** to continue.
Step 2 – MyAssistant License Agreement

Read and accept the Innovative Software Design End-User License Agreement. You must accept the Innovative Software Design License Agreement to use the Sage 300 CRE MyAssistant software.

Click [Next] to continue.
Step 3 – Prerequisites for MyAssistant Workstation

This window displays the prerequisite software that MyAssistant will install. The green check mark is beside the software already installed on your machine. The blue circle is beside the software MyAssistant will need to install. If all prerequisites are already installed, this step will be skipped.

Click [Next] to continue with the MyAssistant Workstation Install.
Step 4 – Install the Software

In this step you will determine where the MyAssistant program files will be installed on your workstation.

Accept the default location or use the [Browse] button to specify a different location.

Click [Next] to install the MyAssistant software on the workstation.
Step 5 – You Have Completed Installing MyAssistant

Congratulations, MyAssistant has successfully been installed on this machine. When launched for the first time MyAssistant will ask you to provide some basic information to activate and connect to the MyAssistant Server.

Click [Finish] to close the setup wizard.
Chapter 4 – MyAssistant Workstation Configuration

After you complete the MyAssistant Workstation install, there will be a shortcut to MyAssistant on the desktop. The first time MyAssistant is opened by a different user, each will be asked to activate the software and specify their user-specific settings.

Setting up the MyAssistant Workstation will take approximately 5 minutes.

Step 1 – Welcome Screen

If there is not a shortcut on the desktop, follow the path below to open MyAssistant:

Open the Windows Start Menu > All Programs > MyAssistant (Folder) > MyAssistant
Step 2 – Product Activation

You must activate MyAssistant in order to use it. A working internet connection is required to complete this step.

NOTE: The Web Proxy Server connection fields will only be available if you clicked [Show Advanced Options] in the Welcome step.

Customer Number – Enter your Sage customer number.

Product Key – Enter the Product Key that corresponds with the MyAssistant edition you would like to activate.

MyAssistant Designer – MyAssistant Designer is the full version of MyAssistant. This version provides the ability to create, activate and change tasks as well as run tasks, and view the notification logs.

MyAssistant – MyAssistant has the ability to run tasks on demand and view the notification log. This version does not provide the option to create, activate or change tasks.

NOTE: Your customer number and product keys were provided with the software. If you do not have this information, please contact Sage Support.
Step 3 – Entering Sage 300 CRE Data Folder Information

The Sage 300 CRE Database Settings are used to connect to your Sage 300 CRE database from the workstation.

Specify Sage 300 CRE data folder locations – The data folders specified during the MyAssistant server setup will be listed in the grid. MyAssistant will automatically set up an ODBC data connection for each Sage 300 CRE data folder given the specified location\path. Click in the Sage 300 CRE Folder Location column and then the ellipsis “…” button to select the appropriate path for each Sage 300 CRE data folder. (You may not see all of your data folders, which is normal.)

Check the Ignore check box for any Sage 300 CRE data folders that should not be accessed on this workstation.

Sage 300 CRE Operator ID and Password – If security is enabled in Sage 300 CRE, enter your operator ID and password. These credentials will be used to run Sage 300 CRE reports and inquiries, as well as to test conditions.

Clicking Next will test each data folder connection as well as the Sage 300 CRE credentials.
Step 4 – User Profile

Complete the Personal Information step with information for the Windows User on this machine.

Windows User – This field is automatically filled with the Windows user name that is currently logged on to the computer.

Your Name – Enter the user’s name.

Email Address – Enter the user’s email address.

Sage 300 CRE MyAssistant will start when you click [Finish] in the wizard.
Chapter 5 – Additional Settings

Antivirus Exceptions
Sage 300 CRE MyAssistant can send email notifications when specified situations are identified. Many antivirus, Internet filtering or Firewall products block all but a specified list of applications from sending email messages.

If you are running antivirus or Internet filtering software, please add MyAssistant.exe, ISDAdminService.exe, ReportRunner.exe, TaskRunner.exe and MyAssistantConfigurationManager.exe to the exceptions list contained in the antivirus or Internet filtering software. This only needs to be done on the MyAssistant Server.

MyAssistant Drive Mapper Tool
If you use one or more Mapped Drive(s) (i.e., drive letter “T:”) to access your Sage 300 CRE data or programs files, you need to install the MyAssistant Drive Mapper. The MyAssistant Drive Mapper is used by the Windows Service that runs MyAssistant Tasks, to access your Sage 300 CRE data or programs.

How do I know if I need to use the MyAssistant Drive Mapper?
The MyAssistant Drive Mapper needs to be used any time a mapped drive (rather than a UNC path) is used to access Sage data or Program Files. There are several places to review to determine which drives, if any, will need to be mapped using the MyAssistant Drive Mapper.

1. Log onto the Server where the MyAssistant Server software is installed
2. Open the Windows Registry
3. Navigate to \Local Machine\Software\(Wow6432node if on a 64 bit machine)\Timberline\General. If a mapped drive is used in any of the paths, you will need to install the Drive Mapper.

1. Start a Sage 300 application.
   a. If a mapped drive (ex. T:) is used in the path / location of your Sage data folder(s) in Select Company window, the MyAssistant Drive Mapper will need to be installed.
   b. Open the Sage File Locations (File > Company Settings > File Locations) window. You will need to install the MyAssistant Drive Mapper if a mapped drive (Ex. T:) is in the listed for any Sage data files.

   **CAUTION:** The MyAssistant Drive Mapper needs to be used any time a mapped drive is used to access Sage data or Program Files. If you are using UNC paths, do not use the Drive Mapper tool.

Perform the following to install the MyAssistant Drive Mapper Tool:

1. Log on to the computer where the MyAssistant server is installed using a Windows user that has Administrator or Unlimited privileges.
2. Open the folder containing the MyAssistant Installation Files.
3. Using Windows Explorer, copy these two files from the Tools\DriveMapperCommand folder in the MyAssistant installation files:
   - InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll
   - DriveMapperCommand.config

   Place the above files in the following three locations. If you accepted the default location when installing the MyAssistant software, these locations will be:
   1. C:\Program Files\Innovative Software Design\My Assistant
   2. C:\Program Files\Innovative Software Design\MyAssistant\SendService
   3. C:\Program Files\Innovative Software Design\MyAssistant\TaskService
4. Start the Windows Notepad application.
5. Click File > [Open], and select the DriveMapperCommand.Config file from the folder that this file was copied into. The contents of the file should be the following:

```
<DriveMapperConfig>
  <MappedDrive>
    <DriveLetter>T</DriveLetter>
    <UNCPath>\MACHINENAME\TimberlineDataFolder</UNCPath>
  </MappedDrive>
</DriveMapperConfig>
```

6. Replace the value between the `<DriveLetter>` and `</DriveLetter>` labels with the drive letter you use to access your Sage 300 CRE data.

```
<DriveMapperConfig>
  <MappedDrive>
    <DriveLetter>T</DriveLetter>
    <UNCPath>\MACHINENAME\TimberlineDataFolder</UNCPath>
  </MappedDrive>
</DriveMapperConfig>
```
7. Replace the value between <UNCPath> and </UNCPath> labels with the UNC path that the drive is currently mapped to for this user.

```
<?xml version="1.0" encoding="utf-8"?>
<DriveMapperConfig>
  <MappedDrive>
    <DriveLetter>T</DriveLetter>
    <UNCPath>\MACHINENAME\Timberline\share\sharename</UNCPath>
  </MappedDrive>
</DriveMapperConfig>
```

If you do not know the UNC path that the Sage 300 CRE drive is currently mapped as, open Windows Explorer and click on Tools -> Map Network Drive. In the drive letter list, it will show how each drive is mapped.
8. If you have different Sage 300 CRE Data folders on different mapped drives, you will need to map multiple drives. To do this, add a `<MappedDrive>` section for each additional drive.

```
<DriveMapperConfig>
  <MappedDrive>
    <DriveLetter>U</DriveLetter>
    <UNCPath>\MACHINENAME\TimberlineDataFolder</UNCPath>
  </MappedDrive>
  <MappedDrive>
    <DriveLetter>U</DriveLetter>
    <UNCPath>\MACHINENAME\TimberlineDataFolder</UNCPath>
  </MappedDrive>
</DriveMapperConfig>
```

Save your changes using the Save option on the File menu and close the Notepad application.
CAUTION: This chapter is written for clients who will be running the MyAssistant Server and at least one MyAssistant User on a Terminal or Citrix Server.

What is Involved
Here is a list of what needs to be done to install MyAssistant on a Terminal or Citrix Server:
1. Log onto the Server as a System Administrator
2. Run the MyAssistant Server installation
3. Activate MyAssistant with a Server Product Key
4. Configure the MyAssistant Server
5. Log onto the machine with the Windows credentials of the user who will run the software
6. Open the MyAssistant user Application
7. Activate with a MyAssistant user Product Key
8. Configure the MyAssistant User

Before Installing
Before MyAssistant can be activated on any accounts other than the administrator, permissions must be given to specific files. Find a list below of the files. The default paths have been provided for your convenience, however they may vary.

If on Windows 2008:
- C:\Program Data
- C:\Program Files\Innovative Software Design
  OR
- C:\Program Files(x86)\Innovative Software Design

If on Windows 2012:
- C:\Program Data
- C:\Program Files\Innovative Software Design
  OR
- C:\Program Files(x86)\Innovative Software Design

IMPORTANT: Permissions need to be given to these folders prior to activating any MyAssistant users on this machine.

Installing the MyAssistant Server
Return to Chapters 1 and 2 for installing and configuring the MyAssistant Server. When you have completed Chapter 2, return to this Chapter to activate the MyAssistant User Software on this Terminal or Citrix Server.

Activating the MyAssistant Workstation
Once the MyAssistant Server is installed and activated, log onto the Terminal or Citrix Server as the Windows user who will be using the MyAssistant software.
- If there is a MyAssistant icon on the desktop, double click to open the User Configuration Manager.
- If there is not an icon on the desktop follow this path:
  Start > All Programs > Sage > MyAssistant (folder) > MyAssistant
When the User Configuration Manager is open, refer to Chapter 4 to activate the MyAssistant workstation.
Conclusion

This completes the initial setup of the Sage 300 CRE MyAssistant software. The next step is to activate or create MyAssistant Tasks to begin monitoring your business. Please refer to the User Guide for information on using MyAssistant.